Working with Point Clouds in CloudCompare
Sharon Bywater-Reyes (University of Northern Colorado), Emily Kleber (Arizona State University), Edwin Nissen (Colorado School of Mines), J Ramón Arrowsmith (Arizona State University) and Brigid Lynch (Indiana University)
Cloud Compare (https://www.danielgm.et/cc/) is an Open Source software that allows for viewing and manipulation of point clouds. This tutorial will walk you through 1) basic operations and use in CloudCompare, 2) using CANUPO, an Open-Source plugin in Cloud Compare (http://nicolas.brodu.net/en/recherche/canupo/) that allows for point cloud classification, and 3) aligning and comparing two point clouds.
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Part 1: CloudCompare Basics
Install CloudCompare
1. [image: Graphical user interface, table

Description automatically generated]Install CloudCompare https://www.danielgm.net/cc/. Go to the downloads tab and scroll down to the “Latest Stable Release”. Download the latest version and select correct version (either PC or Mac). 
Load Point Cloud Data
1. Open CloudCompare application and then navigate in the drop down menus to File  Open (Fig. 1). Open the point cloud file you want to view. The file type can be .txt, .las, .laz ,.pts, .xyz, .asc, or .csv. 
[image: A screenshot of a computer

Description automatically generated]Figure 2. Preview of point cloud data loaded into CloudCompare. Check that XYZ/RBG values are read in correctly.

Figure 3. The viewing tools menu, located to the left of the main display in Cloud Compare.

Figure 1. Open a point cloud file in CloudCompare


2. Make sure CouldCompare is reading the file in correctly (it shows a preview, Fig. 2). If it has chosen the formatting correctly (this will depend on the file format, in this example X,Y,Z coordinates and RBG values are read in correctly). Click “Apply” and wait for the point cloud to load. Depending on the file type, it may ask if you want a shift in coordinates (for its own internal computation and display purposes). Click Ok or Yes to All. Default settings should be acceptable. 
[image: ]Visualize Point Cloud Data
1. The display will look similar to that in Metashape. You can zoom by scrolling your mouse. You can change the view orientation and drag the cloud by clicking the right mouse button. You can zoom by using the 3D Views drop down menu. Lastly, you can use the left panel “Viewing Tools” menu to change the view (Fig. 3). 

2. [image: A picture containing sitting, table, small, large

Description automatically generated]To save an image of your data, in the drop down menus select Display  Render to File. If you want to include a scalebar and orientation icon select Render Overlay Items (Fig. 4). Figure 4. Example of an image saved from CloudCompare data. Scale bar and orientation icon located in lower right corner. 


3. If your computer is struggling with a large point cloud, you can subsample the cloud from the Main Tools Menu with the “Subsample a point cloud” button (Fig. 5).Figure 5. “Subsample a point cloud” button in CloudCompare Main Tools.


4. [image: A screenshot of a computer

Description automatically generated]If your dataset was compiled from colored images (or another method that includes RBG values) the point cloud will automatically load in color.
You can also color your dataset by elevation by assigning elevation as a scalar field. Select your dataset in the DB Tree panel, then go to Edit from the dropdown menus Edit  Scalar fields  Export coordinate(s) to SF(s) and check “Z” (X and Y are already assigned as a scalar field) (Fig. 6).Figure 6. Export elevation as scalar field. 


5. [image: A screenshot of a computer screen

Description automatically generated]You can change back to RGB (if applicable) by changing the Colors dropdown menu in the Properties panel (Fig. 7). Figure 7. 
Properties Panel in CloudCompare, change what the data is colored by. Select either RBG to show colors from images or Scalar Field to color by elevation.





6. You can also change the color scale and whether the scalebar is visible by changing the Color Scale properties in the Properties Panel (Fig. 8). Change back to RGB (if applicable) by changing “Active” in Scalar Field section to none and the “Colors” drop down (located at the top of the Properties Panel under CC Object) back to RGB. 
[image: Graphical user interface, table

Description automatically generated]









Figure 8. Properties Panel in CloudCompare, showing Scalar Field and Color Scale properties.




Measure Objects in CloudCompare
1. [image: ]From the Main Tools Menu, select the “Point Clicking Button”. 
2. A small menu will appear in the upper right corner with several tools for taking measurements (Fig. 9).


Figure 9. Point Clicking Menu with the tools used for measuring distances between points.


3. [image: A sign on a dirt road

Description automatically generated]Select the tool for two points, click on an area of interest and then click on a second point. The tool will display the distance between two points, as well as the horizontal and vertical distances between them (Fig. 10). The tool for three points works in a similar way but will display area and angles between the three points. Figure 10. Example display for measurements between two points. 


4. You can measure the geometry of an object more accurately by fitting a plane to a feature of interest and determining its slope. Start by cutting out the feature of interest, so you will be fitting a plane to only that feature. 
5. In the Main Tools Menu, click on the scissor icon [image: ]then use the polygon shape [image: ]to select the region of interest and right click when finished. 
6. Click the green check mark if you are happy with your result. Click on the polygon shape again and you will have your area of interest.
7. With your point cloud selected in the DB Tree, in the drop down menu, select Tools Fit Plane. This will fit a plane to the surface. In the DB Tree menu, you will now see the dip and dip direction of your selection (Fig. 11).
[image: Graphical user interface, text, application

Description automatically generated]Figure 11. Example of the DB Tree showing the dip and dip direction for the selected feature in the point cloud.


Part 2: Point Cloud Classification with CANUPO
With the use of CloudCompare, you can explore visual and quantitative assessments about your point cloud. However, without classification, we cannot do much with the point cloud. To make a digital terrain model (DTM), or digital elevation model (DEM), we need ground points separated from vegetation points. Likewise, if we were interested in vegetation (e.g., canopy model), we would also need the vegetation classified. 

With airborne LiDAR, multiple returns are registered by the instrument. Because it is administered from the top down (from an aircraft), airborne LiDAR receives a first return that hits the top of the canopy, and a last return that is likely to be a ground point. As such, with airborne LiDAR, last returns can be isolated to form a ground model. For [image: Graphical user interface, application

Description automatically generated]SfM and TLS, a separation based on returns is not possible, thus, a different method of classification has to be used.  
Luckily, an open-source classification is included as a CloudCompare plugin called CAractérisation de NUages de POints (CANUPO).http://nicolas.brodu.net/en/recherche/canupo/ 

In short, CANUPO takes advantage of the “signature” of different features across scales and in 1D, 2D, and 3D. For further documentation on CANUPO: https://www.cloudcompare.org/doc/wiki/index.php?title=CANUPO_(plugin)Figure 13. Example showing selection of several subsamples of tall vegetation classification. 


[image: A picture containing map

Description automatically generated]Figure 12. CANUPO processes a Raw 3D point cloud (left) and classifies it into different categories (right).


Subsample Classes
1. First you will subsample classes using CANUPO. The first step in classifying with CANUPO is to cut out examples of each class. Click on the scissors tool[image: ] in the Main Tools Menu. Use the polygon tool [image: ] to cut out an example.  Click the green check mark if you are happy with your result. Repeat to have several subsamples of the feature you are attempting to train the classifier to identify. For example, tall vegetation, as in the example below (Fig. 13). 
2. When you have subsamples of the class (e.g., vegetation), recombine the clouds into one using the Merge Tool in the Main Tools Menu. Select all of the clouds that contain the same class and click on the Merge Tool button. [image: A sign on the screen

Description automatically generated] 
3. Repeat steps 1-2 to create a classification for ground. 
4. Rename these clouds with the appropriate classes (“Vegetation” and “Ground”) by double clicking each cloud. 
Create a Trained Calssifier 
1. Go to the Plugins menu from the dropdown menu. Click on Plugins  CANUPO  Train Classifier
2. From the Data dropdown menus, change class #1 and class #2 to correspond to your subsampled clouds (Vegetation and Ground). Keep all other settings the same as the defaults and save a classifier (.prm). After saving, select Done.
Classify the Cloud
1. Go to the Plugins menu from the top dropdown menu. Click on Plugins  CANUPO  Classify. 
2. You will typically want to classify your entire point cloud, but after cutting out subsamples from the cloud you will need to reimport the original cloud into CloudCompare. You don’t want to merge the subsamples back with the original point cloud because you will lose the subsample clouds. 
3. In the file menu, navigate to the .prm file you just saved and make sure the cloud you want to classify is selected, either in the DB Tree or using the drop down menu next to “Use other cloud”. Click Ok (Fig. 14).Figure 14. CANUPO classify tool. Select the .prm file you created and select the full point cloud in the Core Points section. 


[image: Graphical user interface, text, application, email

Description automatically generated] 




Filter Points by ValueFigure 16. Example dataset after filtering by ground values. 

1. If you are satisfied with the result, you can filter the point by the scalar field (classification) by using the “Filter points by value” tool located in Scalar Field Tools. [image: A screenshot of a computer

Description automatically generated]
2. Select the range of scalar values corresponding to the “Ground” points and click Export (Fig. 15).
[image: A screenshot of a computer

Description automatically generated]
Figure 15. Filter points by value tool. 



3. [image: Graphical user interface, application

Description automatically generated]Change the color back to RGB and inspect the cloud. In this example, there are a few spurious high points corresponding to vegetation (Fig. 16). 
Clean up Final Ground Cloud
1. You can clean up the resulting cloud by attempting an additional classification or simply cutting out spurious points. You could also use the Clean tool from the Main Tool dropdown: Tools  Clean and try a filter. 
Export Ground Cloud
1. Save your final ground cloud, select File  Save and choose ascii as the format. Note, you could also save as .las if you are familiar with that (las is a format used often for airborne lidar).

Create Digital Terrain Model from Ground Points
[image: Graphical user interface, map

Description automatically generated]From here, you have a number of options for gridding the points to create a rasterized version (e.g. digital terrain model or digital elevation model). We will use CloudCompare’s rasterize tool. This will create a 2.5D model, meaning a rasterized version of the data from a top-down view. Each raster cell will have a value corresponding to the elevation when we are done. This is, in effect, a digital terrain model (DTM) or a digital elevation model (DEM). 
1. From the main dropdown menu, choose Tools  Projection  Rasterize. For the cell size, you could pick something like 0.1 m (10 cm) or larger if your computer is struggling to process the point cloud thus far. In the Projection panel pick Z for direction. For cell height, you can choose minimum if you had a little vegetation noise left in your cloud. This will choose the minimum elevation value in the cell. Otherwise, you could choose average to take an average of the points within the cell. Click “Update Grid” and you will see a preview (Fig. 17). Figure 17. The rasterize tool in CloudCompare. Image on the right shows a preview of your raster. Left panel provides options for setting projection direction, cell height, etc. Bottom left panel allows you to export rasters of elevation, hillshade etc. 

2. In the Export panel (Fig. 17), you can export the raster with the minimum or average (whichever you choose) value of the points within the raster window. There are tabs for Contour plot, Hillshade, and Volume. Start with the Height grid values as your active layer and click “Raster.” Choices for exporting, include the RGB colors, heights (elevation), scalar fields, and density. Select “Export heights.” Note: you can export the entire point cloud with a field associated with the CANUPO Class. This would be useful if you were interested in keeping the entire cloud or looking at the vegetation.
3. You can also export a Hillshade. Click the Hillshade tab (Fig. 17) and click “Generate” to preview. Hillshades allow your eye to see elevation in a more 3D view than a simple color scale with elevation values. 
Part 3: Differencing Point Clouds
Align Datasets
1. Load in two point clouds following the steps from above (Part 1). Under properties, change scalar field to intensity for both data sets. 
2. Rough Alignment 1: Align the datasets using translate/rotate. Click on one of the datasets in the DB Tree window. Then click the Translate/Rotate button.[image: A picture containing logo

Description automatically generated] 
To translate the data, right click on the dataset in the 3D view window and drag the data, to rotate the data, left click on the dataset in the 3D view window. You can deselect Tx, Ty, or Tz in order to change one directional component at a time. To accept the position of the dataset click the green check, to decline it click the red ‘x’. 
3. Rough Alignment 2: Aligning with equivalent points. Note: Changing the coloring and/or visible scalar field may help to distinguish similar features between datasets. Click on both datasets in the DB Tree window. Then click the “Align two clouds by picking equivalent point pairs” button. [image: ]
You will pick which data will be the aligned dataset, use either the newer or smaller dataset as the aligned dataset. The second dataset will be the reference dataset. A new dialogue box will appear, checking/unchecking either the “show aligned cloud” or “show reference cloud” allows you to toggle between the two (Fig. 18). 
[image: Graphical user interface, application, Word

Description automatically generated]Figure 18. The align with equivalent point pairs tool. Toggle between two datasets by selected/deselecting “show reference/aligned cloud”.  

Find features (at least 3) within the two datasets that are the same (i.e. bushes, structures). These features should be spread across the dataset and not arranged in a straight line. First, uncheck “show aligned cloud” so you only see the reference data (Fig. 18). Left click on 3 (or more) features, they will be labeled in the order that you click them (R0, R1, R2…), remember this order for selection on the second dataset. Uncheck “show reference cloud” and check “show aligned cloud”, you should now see the aligned cloud. Left click on the same features in the same order as before, they will be labeled (A0, A1, A2, …). Now select align in the dialogue box (Fig. 18), the aligned dataset will move to the reference dataset. Select the green check if the results look good. A new box will appear with the transformation matrix that was applied to the aligned dataset, click OK. 
4. Fine alignment using ICP: After you have roughly aligned two datasets you can make a final adjustment. To do this, both clouds should have a reasonably large overlapping surface. Select both clouds that you are trying to align. Then select the Fine registration Button in the Main Tools Menu. [image: ]

Choose the newer or smaller dataset as the to be aligned data. The RMSE is the minimum registration error decrease between two steps. If the registration error doesn’t decrease by more than this quantity between two iterations, the algorithm will stop. The default values should work but RMS difference may be increased and Random Sampling Limit may be decreased to speed computation time if necessary. Click Ok, the two datasets should now be very closely aligned. 
Cloud to Cloud Comparison 
1. With both datasets highlighted, select the “Compute cloud/cloud distance” button.
 [image: A close up of text on a white background

Description automatically generated]
2. Choose the cloud you will use as the reference and the comparison. If the clouds cover the same extent, use the older dataset as the reference cloud. If the clouds cover different extents, use the larger extent cloud as the reference. 
3. A dialogue box will appear. Select split X,Y, and Z components, the other default settings should work for most data sets, if the point clouds are sparse, you may want to change the “Local Model” settings. 
[image: Graphical user interface, text, application

Description automatically generated]Figure 19. Dialogue box for the Compute cloud/ Cloud Distance tool. 

4. Click Compute. The compared cloud will now be colored by the distance of the difference between the two clouds and will have 4 new scalar field “C2C absolute distances” and the X, Y, and Z components of the cloud comparison distances. Change the Active Scalar Fields in the property panel to view the individual X, Y, and Z components. 
 [image: Graphical user interface, application

Description automatically generated]Figure 19. Change the Active Scalar Field in the Properties panel to see the 4 C2C distance components (absolute, X, Y, and Z. 


5. You can click on the histogram button [image: Chart

Description automatically generated] and a plot showing a histogram of the differences will appear. 
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